
ISPSoft Revision History 

Version: 2.02 
Date of Publication: Feb. 01, 2013 
 
1. An extension module wizard is added. 

Users can only use this function in the projects for DVP series PLCs. After users click  on 
the toolbar in a program editing window, they can enable the extension module wizard. 

 
 
 

 



2. Users can open the API List window when they edit a ladder diagram. 
When users type an instruction in a project for a DVP series PLC, they can click the button in 
the red frame shown below to open the API List window. 

 

 

 

 
3. Move Up (Alt+Up) and Move Down (Alt+Down) are added to the context menu which will 

appear after users right-click a symbol table. 

 

 
4. If the number of input/output variables of a function block used in a ladder diagram is changed, 

the number of pins of the function block will also be changed. If the positions of the input/output 
variables of a function block used in a ladder diagram are changed, the positions of the pins of 
the function blocks will also be changed. 
 

 
 



5. In the projects for DVP series PLCs, the use of P labels to indicate P devices is replaced by the 
use of texts. 

 
 
6. P (Rising), F (Falling), S (Set), and R (Reset) are added to the instructions which can be typed 

in a ladder diagram. 

    
 

    
 

    
 

    
 

7. Owing to the fact that the firmware version of AH500 series CPU modules is updated to version 
1.01, the compiler of ISPSoft is optimized. When a project is downloaded to an AH500 series 
CPU module, ISPSoft determines whether to compile the project again by checking the version 
of the AH500 series CPU module and the version of the project. 

8. The online monitoring function is improved. 
9. In VFD-C2000/VFD-CP2000/VFD-C200, the maximum M device address becomes M1399, 

and the maximum D device address becomes D1619. 



10. AH10DNET-5A can be set by means of Intelligent Module Configuration. 

 
 

11. The assignment of devices to AH10DNET-5A is modified. 
Before: The default start input/output address is 5000/6000. The default length is 0. 

 
 
After: The start input address and the start output address are assigned by HWCONFI. The 

length specified by HWCONFIG is 500. 

 

 
12. The backup file (.DUP) contains the PLC Link constructed in NWCONFIG. 

 

 

 



Version: 2.03 
Date of Publication: June 05, 2013 
 
1 The English version of the help file about the PLC Instrucions and the special registers in AH 

series models is added. 
2 The efficiency in monitoring a DVP series model online through Ethernet is increased. The 

models supported are EH3/EH3-L/SV2 version 1.80 (and above), and SA2/SX2 version 2.66 
(and above). 

3 1000 steps in a program can be edited online. The models supporting this function are 
SA2/SX2 version 2.66 (and above), EH3/EH3-L/SV2 version 1.82 (and above), and 
ES2/EX2/ES2-C version 3.22 (and above). 

4 The ladder diagram compiler is optimized so that the number of steps in a program will be 
decreased after the program is compiled. 

5 If a lable is modified by an index register in the program in a DVP series PLC, e.g. Label@E0, 
an error occurs when the program is compiled. This prevents the execution of a program fron 
jumping to an uncertain P address. 

6 SA2/SX2 version 2.66 and above support the instruction FTC. 
7 A network port is added to SE in NWCONFIG. 
8 EH2-L and EH3-L can be connected to EN01 in NWCONFIG. 
9 The function of setting Ethernet data exchange is added to HWCONFIG. 

The function of exchanging data through Ethernet is added to AH series models. An AH series 
model can exchange data with a DVP series PLC or a device supporting standard Modbus 
instructions. Users have to set data exchange by means of HWCONFIG. An AH series CPU 
module whose firmware version is 1.02.0 or above must be used. 

 
 

10 Ethernet data exchange can be backed up onto a .DUP file. 



11 Users can change several data types in a device monitoring table at the same time. They have 
to select the data types which they want to change, right-click the mouse, point to Monitor 
Radix on the context menu, and click a data type. 

 
 



Version: 2.04 
Date of Publication: Aug. 29, 2013 
 
1 The instructions MC and MCR are added to VFD series models. 
2 The ST (structured text) compiler is modified. (The compiling of a REPEAT loop is modified.) 
3 The problem that an error occurs when the Modbus Data Exchange parameter in HWCONFIG 

is downloaded to AHCPU500-EN/AHCPU510-EN/AHCPU520-EN is solved. 
4 The inconsistency between the items on the PO List in HWCONFIG and the fact is resolved. 
5 AIO Wizard Setting is modified. (If no module is configured, an error will occur after users click 

Next.) 
6 Auxiliary Setup for Extension Modules is modified. (The instructions added to the list for an 

extension module may be lost if the extension module is set repeatedly.) 
 



Version: 2.05 
Date of Publication: Sep. 19, 2014 
 
1. A Delta library is added to ISPSoft. 

 Usage: After users drag a Delta function block contained inside the Delta Library section in 
the project management area to the editing area, the function block will be automatically 
added to the project. 

 
 
 Introduction of the Delta function blocks  

 DFB_DP_Diag (Only for AH500 series PLCs) 

 
 
Description: When AH10PFBM-5A serves as the master, the function block can be 
used to achieve a diagnostic function. There are internal devices (similar to registers) 
for storing error messages and user-defined information in a PROFIBUS slave. An 
error code will be written to the devices if an error occurs in the slave. Users can read 
error messages and self-defined information in the PROFIBUS slave by means of the 
function block DFB_DP_Diag. 



 DFB_DPV1_C1_R (Only for AH500 series PLCs) 

 
 
Description: The function block shown below is used to read data in AH10PFBM-5A. 

 DFB_DPV1_C1_W (Only for AH500 series PLCs) 

 
 
Description: The function block shown below is used to write data to AH10PFBM-5A. 

 DFB_DNET_EXP (Only for AH500 series PLCs) 

 

 
Description: When AH10DNET-5A serves as a DeviceNet master, the function block 
can be used to achieve the sending and the receiving of explicit messages. The 
function block can be used to write parameters to a slave, or read parameters in a 
slave. 



 DFB_FIFO_DW (Only for AH500 series PLCs) 

 
 
Description: The function block is used to read data (a double word) in the data table 
whose start address is specified according to FIFO. It can be used with the function 
block DFB_Table_DW. (Note: When the function block is executed, interrupts are 
stopped temporarily.) 

 DFB_FIFO_W (Only for AH500 series PLCs) 

 
 
Description: The function block is used to read data (a word) in the data table whose 
start address is specified according to FIFO. It can be used with the function block 
DFB_Table_W. (Note: When the function block is executed, interrupts are stopped 
temporarily.) 

 DFB_Table_DW (Only for AH500 series PLCs) 

 
 
Description: The function block is used to put a value (a double word) in the data table 
whose start address is specified. It can be used with the function block DFB_FIFO_DW 
or DFB_LIFO_DW. (Note: When the function block is executed, interrupts are stopped 
temporarily.) 

 DFB_Table_W (Only for AH500 series PLCs) 

 
 
Description: The function block is used to put a value (a word) in the data table whose 
start address is specified. It can be used with the function block DFB_FIFO_W or 
DFB_LIFO_W. (Note: When the function block is executed, interrupts are stopped 
temporarily.) 



 DFB_LIFO_DW (Only for AH500 series PLCs) 

 
 
Description: The function block is used to read data (a double word) in the data table 
whose start address is specified according to LIFO. It can be used with the function 
block DFB_Table_DW. (Note: When the function block is executed, interrupts are 
stopped temporarily.) 

 DFB_LIFO_W (Only for AH500 series PLCs) 

 
 
Description: The function block is used to read data (a word) in the data table whose 
start address is specified according to LIFO. It can be used with the function block 
DFB_Table_W. (Note: When the function block is executed, interrupts are stopped 
temporarily.) 

 DFB_Lead_Lag (Only for AH500 series PLCs) 

 

 
Description: When the function block is executed, the value of In is read. After a 
lead/lag calculation is done, the result will be sent to Out. If Gain<=0.0 or 
Cycle_TM+LG_TM=0.0, an error will occur. If an error occurs, the function block will 
not process any data, and the value of Out will remain unchanged. 

 DFB_Signal_AVG (Only for AH500 series PLCs) 

 
 
 
 



 
Description: When the function block is executed, Signal_In is read. After the values 
read are averaged, the average will be sent to AVG_Out. If the number of values read 
is greater than the setting value of Samples, the values read will be processed 
according to FIFO, and an average will be calculated and sent. (Note: When the 
function block is executed, interrupts are stopped temporarily.) 

 DFB_COM1_Protocol, DFB_COM2_Protocol, DFB_COM3_Protocol (Only for DVP 
series PLCs) 

   
 
Description: Users can rapidly set the communication format of COM1/COM2/COM3, 
the station address of COM1/COM2/COM3, and a communication timeout without 
having to refer to a manual for more information about the calculation of a 
communication format. 

 DFB_SX2EX2_2DA (Only for DVP series PLCs) 

 
 
Description: Users can rapidly set the modes in which two channels in a 
DVP-SX2/DVP-EX2 series PLC operate and analog output without having to refer to a 
manual for more information about the calculation of the parameters needed. 

 DFB_SX2EX2_4AD (Only for DVP series PLCs) 

 
 
Description: Users can rapidly set the modes in which four channels in a 
DVP-SX2/DVP-EX2 series PLC operate and the conversion of analog input without 
having to refer to a manual for more information about the calculation of the 
parameters needed. 



 If users press F1 on the keyboard after they click a function block in a ladder diagram or in 
the project management, they will have a more detailed description of the function block. 

 
 

2. A program comparison function is added to ISPSoft. It can be used to compare the current 
project with an .isp file on the computer. 
 Usage: Open a file, point to Porgram Comparison on the File menu, click Compare with 

File on the context menu, and select a file. 

  

 



 After the current project is compared with an .isp file on the computer, the differences 
between the current project and the .isp file will be listed in the Program Comparison 
window. If users double-click an item in the Program Comparison window, the program 
section corresponding to the item will be displayed. 

 
 

3. The instruction COMRS is added to AH500 series PLCs. Please refer to PLC Instruction and 
Special Registers Reference for more information. 

4. The instructions DRAMP, DSORT, DRAND, MVM, DMVM, WSUM, and DWSUM are added to 
DVP-SX series PLCs. Please refer to PLC Instruction and Special Registers Reference for 
more information. 

5. The function of editing registers in an AH500 series PLC, and the function of editing the states 
of devices in an AH500 series PLC are added to ISPSoft. 

 



 

 
 

6. The models CT2000 and CH2000, and the instructions SCLP, CATCH, BSET, MEAN, MEANP, 
DMEAN, and DMEANP are added to ISPSoft. 

7. The editor used to edit sequential function charts is optimized. 
 The editor can be used to select several objects, copy objects, cut objects, and paste 

objects. 
Users can click where they want to begin selection, hold down the left mouse button, and 
drag the pointer over the objects that they want to select. In the figure below, the area which 
is selected is shown in grayscale. The area can be copied or cut. 

 
 
 
 
 
 



After the area is copied or cut, it can be pasted. Please see the figure below. 

 
 

8. After users double-click an action or a transition in a window, an editing window will appear, 
and the two windows will be tiled horizontally but take on a vertical shape. 

 

 
 Users can drag an action in the project management area to a step. 



      
 

9. Global symbols are differentiated from local symbols by color. The default color of global 
symbols is purple. Users can set the color of global symbols in the Options window. 

 

 

 

 
10. The Show auto complete list checkbox is added to the Options window.  

If the Show auto complete list checkbox is selected, the variables created will appear in the 
drop-down list boxes in the editing windows. If there are many variables, it may take time for the 
variables to appear in the drop-down list boxes, and users can consider unselecting the Show 
auto complete list checkbox. 

 
 



 
 

11. AH10COPM-5A is added to ISPSoft. 
AH10COPM-5A is a CANopen communication module. It can function as a master station or a 
slave station. It provides a solution to the data exchange between an AH500 PLC and a 
CANopen slave station. 

 

 
12. A memory card function is added to DVP40ES200RM. In the project created for a DVP-ES2 

series PLC, users can use PLC Memory <=> Memory Card on the PLC menu. 



13. Owing to the fact that DVP-ES/EC2/EC3 series PLCs are upgraded, the password function is 
modified so that it is similar to the password function of DVP-ES2 series PLCs. 
New password mechanism: After users set a new password, the new version of the software will 
automatically check whether the firmware version of the PLC used is 8.20 or above. If the 
firmware version of the PLC used is 8.20 or above, the PLC will be locked by the new password. 
If the firmware version of the PLC used is not 8.20 or above, the PLC will be locked by the old 
password. 
Note: After users use the new version of the software to set a new password successfully, they 
can not use an old version of the software to removce the password. 

14. Owing to the fact that the firmware of VFD-C series models 
(C2000/CH2000/CT2000/CH2000-H/CP2000/C200) is upgraded, the MEAN instructions 
(MEAN, MEANP, DMEAN, and DMEANP) are added to the models. 



Version: 2.06 
Date of Publication: Jan. 06, 2016 
 

1. ISPSoft now can work with the following 6 new models, AHCPU511-EN, AHCPU511-RS2, 
AHCPU521-EN, AHCPU531-EN, TP70P-IO and TP70P-RM.   
 

2. New function blocks are added for HVAC for DVP and AH Series. Please refer to the Help file 
on ISPSoft for detailed descriptions on the newly added function blocks.     

 DFB_AirDewPoint (ver. 1.00)  
 DFB_AirEnthalpy (ver. 1.00) 
 DFB_AirHumRatio (ver. 1.00) 
 DFB_AirPsychrometrics (ver. 1.00) 
 DFB_AirVolume (ver. 1.00) 
 DFB_AirWetBulb  (ver. 1.00) 
 DFB_CompPower (ver. 1.00) 
 DFB_RefrigerantP2T (ver. 1.00) 

 
3. AH Module: 

AH08DA-5A module is newly added.  
 

4. Newly added instructions:  
New instructions are added for DVP ES2, including INITC, ASDON, CASD, DDRVIC,DDRVAC, 
PLSVC, ZRNC, CANWR, CANRD and COPRW. Please refer to the option “PLC instruction 
and Special Registers Reference” in the Help section on ISPSoft. 
 

5. The specifications of the editor and compiler are modified.  

 All series: The first character of the variables name cannot be numeric or the compiler will 
send errors.  

 All series: The use of label is not allowed on the section of the instruction MCR or the 
compiler will send errors.  

 DVP series: The basic instructions are added to support the qualifying operands, e.g., LDP 
M0@E0. 

 AH series: The instruction RST is added to support the qualifying operands, e.g., RST 
M1000@E0. 

 AH series: Up to 32 pieces of the variables of the identifiers are available in the function 
block.  

 AH series: The instructions TMR, TMRH, CNT and DCNT are added to support the 
qualifying operands.  



 AHCPU511: Instead of using the S device in the variables of the STEP type, the SFC 
compiler will use the internal memory in the device.  

 

6. The editor of SFC is optimized.  
New actions can be created more quickly by clicking on the … button in the step as the image 
shown below.  

 
 
7. For ES/EC2/EC3 series with firmware V8.20 and above, password now can be edited and 

changed to increase the protection.  
Attention: After a new password is set via ISPSoft with new firmware V2.06, the password 
cannot be changed by ISPSoft with old firmware V2.05 or any previous versions.  
 

8. For DVP series, users can add and reset the RTC functionality from the calendar window on 
ISPSoft.  

 
 



Version: 3.00 
Date of Publication: April 18, 2016 

 

1. ISPSoft V3.00 now supports 3 more models, including AS332T, AS332P and ASS324MT. 
 

2. HWCONFIG for newly added models in AS series 
 Designed with no backplane, the CPU module in AS series are equipped with function 

card slots and can support right-side extensions. Module setups can be done in 
HWCONFIG; as for the extension module setups, users need to go to the PLC 
parameter setting window. The setups will be updated in HWCONFIG and the 
information list simultaneously.  

                                 
 
          
 
 
 
                               

3. Position Planning Table   
 ISPSoft V3.00 provides an easy table for users to set up the single-axis or 2-axis motion 

control. It is not required for users to know the complicated motion control rules to 
complete the setup. Create and download a position planning table and then along with 
the instructions, the PLC can output axis motions in the set number and order 
accordingly.  

 
Click Wizard (!) > Position Planning Table on the tool bar to open the Position Planning 
Table window as the image shown below.   
 

 
Setup area Various Setups 

Function Card 

 

 

Extension 

 



 

4. Data Tracer 

 Data Tracer can be used after a trigger to collect the variable symbols or values/states of 
a device to create a diagram of curve for users to analyze.    
 
Before using this functionality, users need to complete the programming for the current 
project. Click Wizard (!) > Data Tracer on the tool bar to open the Data Tracer setup 
window as the image shown below.   

 

 

 

5. Data Logger 

 Data Logger can be used to collect the long-term records of the variable symbols or 
values/states of a device to create a diagram of curve for users to analyze.    
 
Before using this functionality, users need to complete the programming for the current 
project. Click Wizard (!) > Data Logger on the tool bar to open the Data Logger setup 
window as the image shown below.   



 

 

6. User-defined Data Type (UDT) / Data Type Unit (DUT) 
 Sometimes basic data types are not sufficient for users to write their own programs for the 

PLC. In the IEC 61131-3 standard, a high-level language such as the user-defined data 
type is adopted to create a new data type as users desired, allowing users to define their 
own variables and improving the readability and the efficiency of developing a program.  

 
(1) Structure: a structure is the collection of data, consisting of same amount 

various data types. Structured or array elements can be elements for other 
structures. A structure is used for grouping data and can be seen as a data unit 
to transfer parameters. 
 

(2) Enumeration: users can enumerate the elements in a collection of objects, 
providing an efficient way to define a set of named integral constants that may 
be assigned to a variable and values that the enumeration represents.  

 



Version: 3.02 
Date of Publication: July 25, 2016 
 

1. ISPSoft V3.02 now supports VFD-MS300, VFD-MH300, AS332T, AS332P and AS324MT 
models.  
 

2. ISPSoft V3.02 now supports AH08EMC-5A, AH10EMC-5A, AH20EMC-5A models.  
(Henceforth, the three product series, AH08EMC-5A, AH10EMC-5A, AH20EMC-5A will be 
referred to as AHxxEMC series.) 
 

3. HWCONFIG for newly added models in AS series 
 Designed with no backplane, the CPU module in AS series are equipped with function 

card slots and can support right-side extensions. Module setups can be done in 
HWCONFIG; as for the extension module setups, users need to go to the PLC 
parameter setting window. The setups will be updated in HWCONFIG and the 
information list simultaneously.  
 
 
 
      
 
    

 
4. HWCONFIG for newly added models in AHxxEMC series 

Be sure to refer to the relative manuals before any setup. In order to prevent any personal 
injury or property damage, make sure all the setups are done logically.  
 
Double click HWCONFIG to go to HWCONFIG page and double click the CPU icon to go to 
the setting page.  
 
There are various setting options on the setting page. Select the option tab on the top, users 
will see detailed setting items are listed and categorized into 6 groups, Parameter name, 
Value, Unit, Default, Minimum and Maximum on the right side of the page for users to 
configure. Select other tabs on the top for different data exchanges.  

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 

Function Card 

 

 

Extension 

 



 

 

5. Newly added Main Table and Axis Table for AHxxEMC Series 
Axis provides a connection between the motion control in the program and the physical 
output device. Axis stores various motion control information such as position, velocity and 
so on. 
Global symbols are classified for easier management; there are different sub-items including 
Main Table, Axis Table and Other Network Symbol Table under global symbols. Main 
Table, same as the global symbols of other models, is used for editing the global symbols. 
Axis Table lists all axis variable names which have already been created. Other Network 
Symbol Table contains the symbols used in other network configuration software such as 
ECAT Builder. For details on other network configuration software, refer to operation 
manuals of the software. 

After the axis is created, the identifier of the axis variable name will appear automatically in 
Axis Table under Global Symbols. Double-click Axis Table to open the Axis Table window. 
 

 

 

6. Newly added Axis Parameter, Monitor and Test Run for AHxxEMC Series 
AxisParaForm, the parameter setting window of the axis will be opened automatically once the 
axis node item is created. Users can double-click Axis Parameter under the axis node item to 
open the AxisParaForm window once more after the window is closed. All settings on motion 
control of the axis are listed in the window as below. For details of axis parameters, refer to the 



user manuals of modules. The set values can be downloaded to the PLC with the project 
together after the setting is done. Refer to their relative manuals on how to upload and 
download the settings. 
 

 
 

7. Newly added G-Code Editor for AHxxEMC Series 
There are 2 options under the G-Code Editor, select G-Code to save the codes in the PLC and 
G-Code (External SD Card) to save the codes to the external SD Card on the PLC. Select one 
of the options and right-click the selected option and then click New to open the New G-Code 
Program setting window. Type a name and an item ID for this G-Code. Users can also set up a 
password to protect the G-Code data. When a password is set, the system will ask for the 
password upon next editing. Up to 32 sets of G-Code can be created (max. 64KB for each set) 
in the PLC and up to 128 sets of G-Code can be created (max. 2MB for each set) in the 
external SD card. 

 

While writing a G-Code in the programming area, the current drawing G-Code will be shown in 
red in the toolpath view area. Users can right-click, hold and drag the mouse to rotate the 
toolpath in the toolpath view area.  

 

 



 

 

8. Newly added E-CAM Editor for AHxxEMC Series 

An E-CAM is to use a cam chart to define the relation between a follower and a cam to 
simulate the movements of a cam controlled by a PLC, making a slave axis to move by the 
master axis according to their defined relation. The benefit of using an E-CAM is that users 
can modify the electronic cam data in an electronic cam in software. Users do not need to 
modify the mechanical design and no concern on the machinery wear and tear.   

Right-click the E-CAM Editor in the project management area and then click New to see a 
New E-CAM Chart setting window. Type a name and an item ID for this chart. Users can 
also set up a password to protect the E-CAM data. When a password is set, the system will 
ask for the password upon next editing. Up to 32 sets of E-CAM can be created. 

 

 

 

      

 



Users can click the Insert a point icon  and then click where they'd like to add the data 
point on the chart. The new data point will be added on the chart and the relative data will be 
shown in the Data setting area simultaneously. Up to 20 rows can be added. 

 

9. The online program monitoring function is enhanced: the updating speed is improved while 
performing multi-pages program monitoring.  

10.  ISPSoft V3.02 supports Continuous Function Chart (CFC) programming language for 
AS300 series. (For detailed illustrations on the CFC programming, please refer to the 
ISPSoft User Index in the Help section of IS 
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11.  ISPSoft V3.02 supports EIP Tags for AS300 series.        
 There are 2 kinds of EIP Tags, including the Produced Tag and Consumed Tag. Symbols 

in the EtherNet/IP Table can be used the same way as the global symbols can be used. 
For the creation and usage of a symbol, please refer to the ISPSoft User Index in the 
Help section of ISPSoft.  
 

 Once the definitions of the Produced Tag and Consumed Tag are complete, the specified 
EIP tags will also be downloaded with PLC programs to the PLC. As for the data 
exchange through the EIP tags in the PLC, it can be done with the EIP Builder. Please 
refer to the EIP Builder manual for further instructions.  

 

 
 

12.  ISPSoft V3.02 adds a High Speed Counter tool for AS300 series.  

 The high speed counter tool allows users to select the number of the corresponding high 
speed counter based on the type of the high speed counter, format of the value to be 
counted and input point number so that DCNT instruction can be set quickly. 
 

 Double-click DCNT instruction in the ladder diagram to open the High Speed Counter 
Setting window as the image shown below. (For detailed illustrations on the High Speed 
Counter Tool, please refer to the ISPSoft User Index in the Help section of ISPSoft.) 

 

 

 

 

 

 

 

 

 

 

13. Four new instructions, including DSPD, PWD, MPG and DPPGB are added for AS300 series. 
For detailed descriptions, please refer to the attachment. 
 

14.  Position Planning Table for AS300 series 
 ISPSoft V3.02 provides an easy table for users to set up the single-axis or 2-axis motion 

control. It is not required for users to know the complicated motion control rules to 
complete the setup. Create and download a position planning table and then along with 
the instructions, the PLC can output axis motions in the set number and order 
accordingly.  



Click Wizard (!) > Position Planning Table on the tool bar to open the Position 
Planning Table window as the image shown below.   
 

 

 

15. Data Tracer for AS300 series 

 Data Tracer is used for the real-time collection of variable symbols or values or states in 
devices after some trigger condition is met so as to draw curve charts for analysis of 
value trends. 
Before using this functionality, users need to complete the programming for the current 
project. Click Wizard (!) > Data Tracer on the tool bar to open the Data Tracer setup 
window as the image shown below.   

 

Setting area Various Setups 



16.  Data Logger for AS300 series 

 Data Logger can be used to collect the long-term records of the variable symbols or 
values/states of a device to create a diagram of curve for users to analyze.    
 
Before using this functionality, users need to complete the programming for the current 
project. Click Wizard (!) > Data Logger on the tool bar to open the Data Logger setup 
window as the image shown below.   

 

 
 
17. User-defined Data Type (UDT) / Data Type Unit (DUT) 
 Sometimes basic data types are not sufficient for users to write their own programs for the 

PLC. In the IEC 61131-3 standard, a high-level language such as the user-defined data 
type is adopted to create a new data type as users desired, allowing users to define their 
own variables and improving the readability and the efficiency of developing a program.  

 
(1) Structure: a structure is the collection of data, consisting of same amount 

various data types. Structured or array elements can be elements for other 
structures. A structure is used for grouping data and can be seen as a data unit 
to transfer parameters. 
 

(2) Enumeration: users can enumerate the elements in a collection of objects, 
providing an efficient way to define a set of named integral constants that may 
be assigned to a variable and values that the enumeration represents.  

 



Version: 3.03 
Date of Publication: June 12, 2017 
 

1. ISPSoft V3.03 now supports DVP-ES2-E models.  
 

2. The DVP projects can be converted into AS300 projects. 
   AS300 series is added in the list for the function of changing the PLC type within a DVP    
   project. Go to Tools -> Change PLC Type for this function. 

 

  
 
Note: The supporting functions, device ranges, and instructions may vary between models. 
Users need to make sure that once the original model is changed to other model, the 
original programs, parameter settings, hardware configurations, and network planning, etc. 
can still function properly.  

 
3. ISPSoft V3.03 now supports AS300 Simulator which is supported by the COMMGR with 

version 1.07 or later versions.  
 

4. Optimized the Data Tracer function. 

Click the icon  on the tool bar and then users will see two vertical lines, X1 and X2. Use 

the mouse to drag the two vertical lines to select the section and have its time measured; the 
value will be shown in IΔXl. And the t behind the value in IΔXl means one communication 
time between the PC and the PLC as the image shown below. 

 

 



 

5. Optimized the SFC editing function.  
SFC (Sequential Function Chart) programming allows users to add actions in the steps. Users 

can now use the fold button  to fold the action list to save space on the screen.  

 
 

6. Changed the status bar display 
Changed the flashing block to a solid one and add the wording (ERR) behind the red block on 
the status bar. When in the On-Line mode, users can learn the scan time and the status of the 
PLC from the status bar. If the block is green, it indicates the communication is on-going. If the 
block is red, there will be a wording (ERR) behind the red block, indicating there is an error 
occurred. As for the wordings, RUN and STOP, RUN indicates the PLC is in operation and 
STOP indicates the PLC is not working.  
 
 

 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

7. Optimized the Position Planning Table. 
Options including Relative (Symbol/Address) and Absolute (System/Address) are added in the 
positioning setting tab. When the options above are selected, devices and symbols can be 
used in the target position. For devices, only data devices are supported. As for the symbols, 
they should be declared in the global symbol table first before being used in the target positon. 
The address should be a data device and the data types should be DWORD or DINT. On the 
right side of the global symbol table, users can input values for simulation. 

 

 



8. Added a new form of curve, polynomial for the E-CAM editing, available for AHxxEMC series 
PLC.  

 

9. Optimized the back-up function. 

Users can set up the backup interval time and the total number of the backup files in the 
Tools -> Options -> Project Setting tab, and the system will save a backup file (*.~bak) in the 
project list accordingly. When needed, users can use the backup file as the project file by 
simply changing the extension file name from (*.~bak) to (*.isp). 

 

 

  

  
  
  
 

 
10.  HWCONFIG supports new models including AS08AD-B and AS08AD-C. 

        Be sure to refer to the relative manuals before any setup. In order to prevent any personal    
        injury or property damage, make sure all the setups are done logically. 
 

11.  Added a new wizard for Extension Module. 
  

12.  ISPSoft user manual is updated accordingly.  
 
 

Download the software at 

http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemI
D=060301&typeID=1&downloadID=,&title=-- Select Product Series 
--&dataType=8;&check=1&hl=en-US 
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http://www.deltaww.com/services/DownloadCenter2.aspx?secID=8&pid=2&tid=0&CID=06&itemID=060301&typeID=1&downloadID=,&title=--%20Select%20Product%20Series%20--&dataType=8;&check=1&hl=en-US
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